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System Admin Time: By Paul Pominville 

There have been many questions asked of the technology staff as to which is 
better: log-off and shut down the computer each day or simply log-off? 

The debate is actually between the following three: 
1.  Locked workstation - stay logged on. 
2.  Log off and leave workstation on. 
3.  Log off and shutdown workstation. 
  
People like to leave their computer logged on and their screen locked at night to 
save logon time in the morning but that hinders our ability to push updates 
down during the logon.  Take our anti virus software, for example, when a user 
logs on any new virus definition files are copied down to the workstation.  If a 
user never logs off they never receive these updates.  Thus they are vulnerable 
to any new viruses.  Another problem with this is that users tend to leave 
applications open behind the locked screen.  This can lead to any or all of the 
following: 
1.  Slows down our backups considerably since it takes more time to backup an 
open file.   
2.  Sometimes the backup software cannot backup open files at all so the 
chance of losing valuable data is increased.   
  
I would recommend the following.  During the weekdays, (Monday through 
Thursday), logoff your computer and leave your workstation on.  It can actually 
be harder on the workstation to go through the power on phase than to leave it 



running.  Remember though, if you choose to log-off and leave the computer 
running, please make sure that the screen is locked. This should occur after six 
minutes automatically, but to be on the safe side, please check for certain 
before walking away from your computer. For Friday, I highly recommend that 
you shut down your PC altogether. If everyone leaves his or her system on all 
weekend that's a lot of electricity being used for no reason. 
  
.  
Another important factor to remember is to close all applications before shutting 
down.  Sometimes if you just shutdown expecting the system to close all the 
running applications you can be surprised that the system is sitting at a point 
waiting for you to save any unsaved work.  There is some safety that the 
system will lock in six minutes if it is left at a save prompt, but again, files have 
been left open and may not get backed up.   
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FYI: The HPS Big Board (located on the public folders section of Outlook) 
was created for people to use to sell or buy items or for announcements 
such as “My dog had puppies…looking for good home,” etc. You can post 
information on the Big Board as often as you like. You can simply view 
what others have posted or you can respond to an item you see there. You 
can only delete or change an item you have put there yourself. You cannot 
delete or change items put on the Big Board by others.  
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Lesson Plan of the Month 
The following lesson plan comes from: 

Best Practices of Technology Integration II from Michigan 
Teachers 
Title: Michigan-Made Products 
Submitted by: 
Name: Kathryn A. Cothran 
School Building: Gibbing Educational Center 
School District: Utica Community Schools 
School Address: 11303 Greendale 
Sterling Heights, Michigan 48312 
E-mail Address: kc9mucs@moa.net 
Subject Area: Social Studies 
Intended Grade Level(s): 4-5 
Description: 



Children learn about different Michigan-Made Products. 
With a partner, chosen by the teacher, the students will create a HyperStudio presentation 
that will detail 6 products that are made in Michigan. 
Each student will research 3 different products that are made in Michigan. The student 
will need to understand the product and know where in Michigan this product is made, 
manufactured, gathered or found. 
Narrative: 
This lesson can bring the industries of Michigan to life within a classroom. The class 
begins to realize that some of the products that they use every day in their homes are 
actually made in Michigan. This project allows students the opportunities to look beyond 
our school walls into the world around them. By working in pairs and encouraging 
creativity this is giving the students 
freedom to make choices about what type of products they are interested in investigating. 
The information shared during the presentations will show if the students have 
internalized the information that has been gathered. Because this lesson encourages 
presenting to other classes or small groups of children in the building, this creates an 
authentic audience for the student sharing 
thereby giving purpose to the project and the learning. 
Curriculum Benchmarks: 
MI.SOC.IV.2.LE.3 Examine the historical and contemporary role a major industry has 
played in the state of Michigan and the United States. 
MI.SOC.IV.2.LE.1 Distinguish between natural resources, human capital, and capital 
equipment in the production of a good or service. 
Total amount of time for lesson: 
Spending one hour a day for 10 days on the activities can complete this lesson. 
Computer time is crucial in the creation of the HyperStudio stack. 
Materials/Hardware/Software: 
Charting products made in the United States (or World) on a bulletin board will need a 
large United States map, pushpins, and string. Information can be gathered from various 
locations such as the Michigan book (McGraw-Hill Publishing Company), magazines, 
library books, grocery stores, etc. The Internet will be extremely helpful in gathering 
information about products. The final presentation is created in HyperStudio (Roger 
Wagner Publishing Inc. ) or some other multimedia tool. 
Digital camera (optional) 
Preparation Teacher: 
Before starting this project the teacher needs to put a large map of the United States (or 
world) on a bulletin board. The teacher might want to gather a couple items to place on 
the map as the introduction to the project--such as attaching a (small) part of the Coke 
case with the logo to the bulletin board with a piece of string pinpointing Atlanta, 
Georgia and a Kellogg’s Cereal box to Battle Creek, Michigan. 
Prerequisite Student Skills: 
Technologically, to complete this project students need to have some HyperStudio skills. 
This makes the project much more timely. Academically, students need to have some 
skills for locating information since the students will not all be gathering the same 
information. 
Student Activities/Procedures: 



To begin this unit about Michigan Products the teacher introduces the desire to find out 
where products are made. The teacher gives the examples of products she has found and 
puts them on the map. Each item to be hung on the map needs the discussion of the 
natural resources, human capital, and capital equipment needed in the production of each 
good or service. This could either be the introduction to these terms or a continuation 
lesson of these terms. Each student is then required to bring in three items to add to the 
map. Each student must also fill out a card for it(there can be found in the attachment) 
and present it to the class. 
Next, present the class with the rubric for the Michigan-Made Product HyperStudio 
Stack. Working in pairs, the students are to create a stack that starts with a map of 
Michigan that they have drawn using the tools in HyperStudio. Each child is to find three 
products from Michigan to investigate further. Each product is made into an individual 
card that explains: What the 
product is...Where it is found...How it is made and of what it is made...Interesting facts 
about this product...Picture of the product (either from the Internet or a digital picture of 
the product).... 
These cards are then linked to the title card by invisible buttons that are activated by 
clicking on the city or area of production. For instance, on my title card map I might have 
a star on Battle Creek. When I click on that star it takes me to a card about Kellogg’s 
Cereal. Another star might be located on Detroit. By clicking there I go to a page about 
Ford Motor Company. The final page of the stack is about the authors and a bibliography. 
After the stack is finished, the students share with other classes around the building and 
with each other (especially good during Michigan Week). Students will give formal 
presentations to their individual classes. These can be video taped and sent home to share 
with the parents. 
. 
Follow-up Activities: 

A fun follow-up activity is to have a Michigan Breakfast (or Lunch) where all the food that is 
served is from Michigan. Each child brings in an item to share.  

  

***If you have a technology-rich lesson that you would like to share with others, 
please send it to colburnc@howellschools.com no later than the last Monday 
of the month.  
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 Carole’s Training Corner  
Training for the month of October has been pretty much limited to doing follow-up sessions with 
the people who completed T4 this summer. There have been some days scheduled at the 
beginning of the month and again at the end of the month to help teachers with submitting both 
progress reports and report cards. I will also focus on ABACUS training for November as well as 
offering “Laptop Help” sessions at the elementary schools.  

mailto:colburnc@hps.k12.mi.us


In addition, there is one more special item to note. We are now a licensed MOUS Certification 
Testing Center here at HPS. We are not completely ready to begin actual testing, but that should 
happen sometime in November or early December. Look for the official MOUS Certification 
symbol and start studying for those tests! ☺ More on this to come in next month’s Tech Times.  

To see the complete list of class offerings for the month, check out the calendar page at 
http://hps.k12.mi.us/training/TrainingCalendarPage.htm   
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ 
You can have these tips e-mailed to you directly each day by signing up at the 
above mentioned site. 
***************************************
SELECTING DEFAULT PARAGRAPH FORMATTING 

******************************* 

Word provides an easy way to remove any explicit paragraph formatting 
that was done to a paragraph. This is all you have to do: 
  
   1. Select the paragraphs that you want to remove the formatting 
      from. 
   2. Press Ctrl+Q. 
  
  
The paragraph formatting for the selected text will be set back to its 
default condition. 
  
********************************************************************** 
  
CHANGING THE NUMBER OF COLUMNS IN THE MIDDLE OF A DOCUMENT 
For some document layouts, columns can be used to present your 
information clearly and concisely. What if you already have a document 
and you want to format only part of it in columns? As a example, let's 
assume you have a five-page document, and you want to format the 
center part of page two as three columns. You want the rest of the 
document to remain a single column. To accomplish this formatting 
challenge, you can follow these steps: 
  
   1. Place the insertion point at the beginning of the text which 
      will appear in the columns. 
   2. Choose Break from the Insert menu. This displays the Break 
      dialog box. 
   3. Choose the Continuous radio button. 
   4. Click on OK. This inserts a continuous section break in your 
      document. 
   5. Place the insertion point at the end of the text that will 
      appear in the columns. 
   6. Repeat steps two through four to insert another continuous 
      section break. 
   7. Place the insertion point anywhere within the text that will 
      appear in the columns. 

http://hps.k12.mi.us/training/TrainingCalendarPage.htm
http://wordtipsgold@vitalnews.com/


   8. Choose the Columns option from the Format menu. You will see the 
      Columns dialog box. 
   9. In the Number of Columns field, specify the number of columns 
      you desire. 
  10. In the Apply To box, make sure it says This Section. 
  11. Click on OK. 
  
  
****************************************
Specifying an Order for Drawing Objects 

****************************** 

  
When you create objects in Excel using the Drawing toolbar, each object 
is drawn on its own layer. This means all objects are independent and 
can be moved on top of other objects. This means that once you have 
drawn a number of different objects you can reorder them so that they 
appear in the order that you desire. You can do this by following these 
steps: 
  
   1. Select the pointer tool (the arrow) from the Drawing toolbar. 
   2. Using the mouse, point to the shape whose order you want to 
      change. Small square boxes called handles appear at each corner 
      in the shape. 
   3. Choose Order from the Draw menu on the toolbar. Excel displays a 
      set of ordering commands. 
   4. Choose the ordering command that represents what you want to do. 
  
You can also access the ordering commands by right clicking on a 
drawing object and choosing Order from the resulting Context menu. 
There are four different ordering commands: 
  
   * Bring to Front. This option places the selected object on top of 
     the layer stack, so it appears in front of any other objects. 
   * Send to Back. This option moves the selected object behind any 
     other drawing objects. 
   * Bring Forward. This option simply moves the drawing object one 
     step closer to the top of the layer stack. 
   * Send Backward. This option moves the drawing object one layer 
     toward the bottom of the layer stack. 
  
*************************
Unselecting a Chart Item 

********************************************* 

  
Excel includes a very powerful charting feature. As you work with 
charting your data, it is not unusual to select different objects and 
then use the various formatting features of Excel to make that object 
look exactly as you want it to. You select chart objects by simply 
clicking on the object with the mouse. 
  
If you select an object by mistake, you can easily undo that selection 
by simply selecting a different object. If you don't want to select a 
different object, but instead want to "deselect" the item you selected, 
all you need to do is press the Esc key. Excel obediently cancels 
whatever selection you made. 
  
********************************************************************** 
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Cool Links For You to Try… 

http://www.discoveryschool.com 

http://www.remc7.k12.mi.us/oaisd/miclimb/ 

http://sln.fi.edu/tfi/hotlists/kids.html 

http://www.pbs.org/teachersource/ 

http://www.mimio.com/education/ 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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http://www.hps.k12.mi.us/Curriculum1.html
http://glen.cc/mtip/
http://www.remc7.k12.mi.us/oaisd/miclimb/
http://www.cyberlearning.org/
http://www.brainbuzz.com/topsites/Default.asp?CatID=1
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